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1.  Introduction 

1.1 Model Concept 
 
MINUHET (Minnesota Urban Heat Export Tool) is a tool used to simulate the flow of 
stormwater surface runoff and its associated heat content through a small watershed for a rainfall 
event or events of interest.  The main output of MINUHET is a time series of flow rate and 
temperature at the outlet of the watershed, to enable prediction of thermal impact on receiving 
streams. MINUHET is event-based, i.e. it is designed primarily to simulate a single storm event.  
The MINUHET tool includes a database of observed and/or synthetic storm events that have the 
potential to produce high thermal loading in receiving streams. 
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Pavement Rooftop  Vegetated/ 

Pervious Connected Disconnected Connected Disconnected 
Type Short Grass Asphalt    
Area (m2) 4600 1120 900 840 880 
Length (m) 60 60    
Slope 0.03 0.03    
Shading (%) 20 20    
Sheltering (%) 20 20    
Soil Type B     

 
Figure 1.1.  Schematic diagram of the process of assembling and running 
an MINUHET model. 
 
The overall process of assembling and running a model within MINUHET is depicted in Figure 
1.1.  MINUHET requires the input of basic descriptions of sub-watersheds (pervious and 
impervious areas, slopes, etc.), drainage network elements (lengths, diameters, slopes, etc.) and 
ponds (bathymetry, output structures, etc.).  The connectivity of the individual components is 
established by constructing a drainage schematic of the watershed.  MINUHET is not capable of 
directly importing spatial information from, e.g., GIS shape files, but GIS software is helpful for 
preparing the needed parameters for the model components.  The drainage network can include 
mitigation ponds, including wet ponds, dry ponds, infiltration pods, underground tanks and rock 
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cribs, and rain gardens. Storm events to apply to the model are selected based on one of seven 
climate regions within Minnesota. 
 
A common application of MINUHET may be to compare the thermal loading of stormwater 
runoff from an area of land before and after development, to quantify possible increases in 
thermal loading due to development.  As a result, MINUHET includes components for 
developed and undeveloped land parcels (sub-watersheds), pervious and impervious open 
channels, storm sewer systems, and stormwater ponds. 

1.2  Model Structure 
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Figure 1.2.  The structure of MINUHET 
 
MINUHET is a self-contained software tool that includes several model component executables 
and a graphical user interface (Figure 1.2).  There are three main sub-programs that perform the 
runoff and heat transfer calculations: the runoff model, the routing model, and the pond model. 
The sub-programs are written and compiled in FORTRAN 90.  Although the model components 
could be run using MSDOS commands, a graphical user interface (GUI) was developed for the 
model to make it easier to design the model, enter the required watershed parameters, and to 
provide visualization of the system layout and simulation results. Under guidance SAFL, the 
GUI was developed by Minnetonka Audio Software, Inc., based on the Microsoft .NET 
framework. 
 
Each of the three main FORTRAN model components must calculate a balance for the surface 
runoff flow rate (Q) and for the heat flux (H) contained in the surface runoff, as shown 
schematically in Figure 1.3.  By definition, sub-watersheds receive precipitation but not surface 
inflow (Qin=0).  Drainage network components and stormwater ponds may add or subtract flow 
and heat content, depending on the particular watershed and storm event. 
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Figure 1.3.  Schematic diagram for the balance of runoff flow and heat flux for each sub-
watershed, drainage network, and pond component. 
 
 
The MINUHET sub-watershed model has two major components: 1) a land surface temperature 
model, 2) a surface runoff model.  The land surface temperature model is based on a surface heat 
transfer model that calculates the radiation, convection, and evaporation components based on 
specified climate.  A one-dimensional finite difference model is then used to calculate the 
vertical conduction of heat through the soil column and the soil temperature profile to a depth of 
three meters.  The MINUHET storm files include at least several days of antecedent climate 
conditions prior to the rainfall event, so that realistic surface temperatures and soil temperature 
profiles are calculated as the rainfall event begins.  During a rainfall event, the surface 
temperature model calculates the heat transfer between the surface runoff and the land surface, 
such that the surface runoff and the land surface reach the same temperature. Details of the 
surface temperature model are given in Section 5.3.1 and in SAFL Project Report #536 (Herb et 
al. 2009). 
 
The surface runoff model was created to simulate runoff from relatively small impervious areas, 
e.g. a parking lot, at high time resolution, for steady or unsteady rainfall events.  The runoff 
model uses an analytic formulation to simulate the time history of flow rate and temperature at 
the outlet of an area with uniform slope.  The analytic model is based on Manning’s equation, 
and closely matches the results of a kinematic wave model.  The runoff model is described in 
more detail in Section 5.3.1 and in SAFL Project Reports #484 and 536 (Herb et al. 2006d and 
Herb et al. 2009).  The surface runoff model also calculates a mean runoff depth for the area, 
which is used by the land surface temperature model to calculate runoff temperature.  The sub-
watershed model also includes a soil moisture model, so that infiltration can be handled for 
runoff from pervious surfaces. 
 
The hydro-thermal routing model uses a kinematic wave algorithm to simulate the flow of water 
and heat through a drainage network.  In its current configuration, the routing model does not 
include atmospheric heat transfer for the routing elements, so that it is not appropriate to simulate 
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long open channel drainage networks.  The routing model does not include junction losses, so 
that MINUHET should not be used as a tool for designing stormwater handling systems.  There 
are three types of routing elements available for simulation of a drainage network: circular storm 
sewer pipes, impervious open channels (e.g. concrete open channels) with trapezoidal cross 
section, and pervious open channels with trapezoidal cross section.  Infiltration and heat transfer 
to the channel/pipe wall, and atmospheric heat transfer are included where appropriate. 
 
The MINUHET pond model can be used to simulate wet detention ponds, infiltration ponds and 
rain gardens, and dry ponds.  The pond model is based on previous 1-D models for lakes (Ford 
and Stefan 1980, Hondzo and Stefan 1993) and wastewater detention ponds (Gu and Stefan 
1995).  Given the inflow rates and temperatures of the storm sewers discharging to a pond, the 
hydrology of the inflows, and the design of any outlet structure, the model projects the rate and 
temperature of the outflow from the pond.  The pond vertical temperature profile is calculated for 
each time step based on atmospheric heat transfer, heat conduction through the pond bottom, and 
the flow rate and temperature of inflows.  Atmospheric heat transfer includes solar and long 
wave radiation components, atmospheric convection, and evaporation.  Pond level is calculated 
based on inflow and outflow rates, infiltration, direct precipitation, and evaporation.   Further 
details on the MINUHET pond model may be found in Section 5.4.1 and SAFL Project Report 
#479 and 536 (Herb et al 2006b). 
 

1.3  Changes from MINUHET version 1.x to version 2.x 
A number of changes have been made to both the FORTRAN executable programs and the user 
interface from MINUHET version 1 to version 2.  While the user operation and input 
parameters are similar, the version 1 model files (*.minu) are not compatible with version 
2.  The following list summarizes the important changes and improvements made to MINUHET 
in version 2.x: 
 
Main Window: 
 

 The main window now has separate icons for wet pods, infiltration ponds, and dry 
ponds. 

 There is a new option in the Tools -> Options drop down menu to specify the 
reference temperature for heat export calculations 

 Additional parameter checking has been added with associated error messages for 
missing parameter specification, etc. 

 
Simulation Run Browser 

 In addition to flow rate and temperature, the user can now plot heat export rate. 
 The graphing window now includes a table of storm-averaged and storm-total 

quantities, including total runoff volume, average runoff temperature, and total heat 
export. 
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 View -> Graph has been added to the drop-down menu, which enables users to 
specify which quantities are displayed in the graphing window. 

 View -> Summary Table has been added, to enable a summary of the results of a 
simulation to be copied to an spreadsheet or saved as a file. 

 
Runoff model 

 The second impervious area specification has been eliminated in version 2.  Each 
subwatershed now contains one impervious area, one pervious area, and one rain 
garden specification. 

 The soil moisture model has been improved to handle continuous simulations of 
several months. 

 
Routing Elements 

 The global routing parameters (depth, soil type, soil moisture) have been eliminated 
and incorporated into the parameter specifications for the individual elements. 

 Atmospheric heat transfer has been added to the open channel elements 
 The ability to introduce a groundwater inflow has been added to the pervious open 

channel elements 
 
Pond Model 

 Improvements have been made to the pond model to better handle, e.g., infiltration 
ponds with zero initial depth. 

 The Reference Elevation (bottom elevation) parameter has been eliminated.  The 
bottom elevation is now taken as lowest elevation in the specified bathymetry. 

 The ability to specify a rating curve for the pond outlet has been added 
 
Underground tank and rock crib models 

 A model for an underground stormwater tank (vault) has been added 
 A model for an underground, rock filled trench has been added 

 
Postprocessor 

 The ability to optionally plot precipitation data has been added 
 Summary statistics are recalculated for the displayed time period as the zoom feature 

is used 
 

2.  Installing MINUHET 
 
Hardware and Software Requirements 
 
MINUHET is currently available for Windows® based computers only.  Apple and Unix systems 
are not supported.  MINUHET requires 10 Mb of hard-drive space for installation and Windows 
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2000 or Windows XP.  Microsoft .NET version 2.0 or better should be installed.  A computer 
with at a Pentium III processor or better and at least 512 mB of memory is recommended. 
 
To install MINUHET, insert the installation CD and run the installMINUET.msi installation 
program.  By default, a SAFL/MINUHET sub-directory in Program Files will be created. 
 

 

3. Using the MINUHET Main Window 
 
Chapters 3, 4 and 5 describe the MINUHET tool in detail and the general methods for using the 
tool to simulate runoff flow and temperature from a watershed. 
 

3.1 Starting MINUHET 
 
By default, installing MINUHET creates a desktop icon and a link to the program in the 
Windows start menu; either may be used to start MINUHET. When MINUHET is started, the 
main window appears (Figure 3.1).  The main window includes: 
 
1) The Workspace on the left.  This area is used to create the schematic layout of the watershed. 
2) The Toolbar contains a set of element icons on the far left. By dragging elements from the 
Toolbar, the user adds sub-watersheds, routing elements, and ponds to the schematic layout. 
 
3) The Element Properties area on the right.  When an element is selected, a set of user-defined 
properties appears in this area. 
 
4) The drop-down menu items at the top 
 
5) The Regional Storm Selection menu just below the drop down menu.  These controls are used 
to select the climate region for the study, based on the county, and a design storm or storms to 
apply to the watershed. 
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Figure 3.1.  MINUHET main window. 
 

3.2 MINUHET Project File Management 
 
For each project (model), MINUHET creates a case file that contains all of the user input 
information for the watershed.  This file is stored in the directory selected by the user when the 
model is saved for the first time.  For example, a folder called MINUHET Projects can be created 
in My Documents, with a sub-folder for each new MINUHET project (Figure 3.2). Each time a 
simulation is run, MINUHET automatically creates sub-folders that contain the simulation 
results files. In general, the user does not need to directory access these folders, since the 
simulation results are accessed via the MINUHET post-processor.  Several versions of the same 
model or multiple models can be saved in the same folder, as long as each model and model 
version is given a distinct project name.  Once a model schematic has been created, the case file 
is updated each time the user saves (File → Save) and each time a simulation is run. 
 
Creating a new model from an existing model. 
 
A new model schematic can be created based on an existing model, as follows; 
 

1. Using the File→ Open to open an existing MINUHET project file (file.minu). 
2. Use File→ Save As menu command to create a new file with a new name and/or and 

directory. 
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3. Edit the schematic in the MINUHET main window. 
 
 

MINUHET Projects

Project file:
Verm_Cross.minu

Verm_Cross_sims

Verm_Cross_2007_2_12_10-50-30

Synthetic01

MINUHET 
generated sub-
folders

My Documents

Vermillion Crossings

Synthetic02

User defined 
sub-folders

 
File 3.2. Example of a file structure for a MINUHET project.  The user has set up a 
MINUHET Projects folder to store all MINUHET models, and a sub-folder, 
Vermillion Crossings, for a specific project.  The user saved the MINUHET project 
file, Verm_Cross.minu, in the Vermillion Crossings folder.  When the user runs the 
model, MINUHET creates the Verm_Cross_sims folder with two levels of sub-
directories to store input and output files for each simulation run.  In this example, 
one simulation has been performed with two storms (Synthetic01 and Synthetic02). 

 

3.3 Choosing a system of units 
 
A MINUHET model can be set up using either SI units (length in meters, area in square meters, 
flow in cubic meters per second) or US units (length in feet, area in acres, flow in cubic feet per 
second).  The system of units is specified using the Tools → Options command from the drop-
down menu (Figure 3.1).  A new project will be in metric units, by default.  In its present 
configuration, the units option changes the units of the input parameters only – the output flows 
and temperatures are always in [m3/s] and [°C], respectively.  The units option can be changed at 
any time, but it is suggested that the units should be selected at the beginning of the model 
construction process. 
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4.  Creating a MINUHET watershed schematic 
 
The process of building a schematic layout includes three main steps: 
 
1) Adding sub-watershed, routing, and pond elements to the layout 
2) Defining the parameter values for each element 
3) Connecting the elements together to define the flow paths of stormwater 
 
The MINUHET schematic layout process is quite flexible, so that the above steps can be 
performed in different orders, as the user chooses.  The example process given below provides 
the details for one approach to building a layout. 
 

4.1 Using the MINUHET Menu Tools in the Main Window 
 

 To drag a new element into the layout, click the left mouse button on the desired element 
icon, and drag the element to the desired position in the layout while holding the left 
mouse button down.  Any existing element in the layout can be re-positioned by selecting 
it with the left mouse button and dragging it to a new position while holding the left 
mouse button down. 

 To set the parameter values for an element, select the element with the left mouse button.  
A menu of parameter values will appear in the element properties area of the window 
(Figure 3.1).  Each parameter appears in a table, with the parameter name on the left and 
an editable value on the right.  As the parameter value in the right field of the table is 
selected, additional information on the parameter appears at the bottom of the element 
parameter area, and a numerical value can be entered.  Some parameters are grouped, e.g. 
for the pervious and impervious areas of a sub-watershed.  To edit the parameters in the 
group, click on the +  symbol to the left of the parameter group name to expand the 
table. 

 Each element is given a default name as it is created.  The name of each element can be 
edited, if desired, by editing the label field at the top of the element parameter table. 

 To connect two elements together, select the element.  Then select the small box on the 
underside of the upstream element with the left mouse button and drag the mouse pointer 
while holding the button down.  Drag the mouse pointer over the downstream element 
and release the button.  A line will be automatically drawn between the two elements to 
indicate a successful connection. 

 If a layout has multiple sub-watersheds, ponds, or routing elements that are similar, the 
cloning command (Edit → Clone Element) can be used to create copes of an element 
after the parameter values have been set.  The parameter values of the new copy can be 
edited to make any minor changes required. 
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4.2 Procedure for Creating a MINUHET Schematic 
 
The following procedure outlines one possible general procedure for creating an MINUHET 
layout.  As the layout is created, it should be saved at regular intervals (File → Save). 
 

1. Place the sub-watersheds into the layout by dragging the sub-watershed icons into the 
layout.  Set the parameter values for each sub-watershed as it is inserted in the layout.  
Each subwatershed must have, at a minimum, at least one impervious or pervious area 
with non-zero area, slope and roughness values. 

2. Layout the drainage network by dragging pipe, open channel, and junction elements into 
the layout area. 

3. Set the slope, diameter, and roughness of each pipe and channel element. Note that 
junctions have no parameter values to set. 

4. Connect the drainage network elements together with the sub-watersheds 
5. Add the detention ponds to the layout, if required, and set the parameters for the pond. 
6. Connect the detention pond(s) to the drainage network. 
7. Set the inflow level parameter for each inflow pipe to the pond elements by selecting the 

pipe. 
 
General rules for drainage network layouts: 
 

 By definition, sub-watersheds are sources of runoff only; they cannot receive runoff from 
other sub-watersheds. 

 The relative position of the elements in the layout is not important for the MINUHET 
analysis.  Flow directions are established by the connectivity of the sub-watersheds to the 
routing elements, and flow distances are determined by the length parameter of the pipe 
and open channel elements. 

 Sub-watersheds may be connected to a pipe, an open channel, or directly to a junction.  A 
sub-watershed may also be analyzed as an independent entity, i.e. a MINUHET layout 
may be composed of a single sub-watershed only. 

 Pipes and open channels have only one inflow and one outflow. 
 Junctions can have up to five inflows from pipes, open channels, or sub-watersheds, but 

have only one outflow. 
 Ponds can both receive inflow and produce outflow.  Ponds can have up to five inflows 

from pipes or open channels, but have only one outlet to a pipe or channel.  A pond need 
not have a pipe or channel connected to its outlet, if it is the most downstream element – 
MINUHET will still calculate the outlet flow rate and temperature. 

 A MINUHET layout may have multiple, independent watersheds.  For example, an 
undeveloped area of land on a hill may drain stormwater in two directions.  The two 
watersheds may be created as two separate MINUHET models or combined into a single 
MINUHET layout, with two, separate calculated outflows for each storm analysis. 

 The most downstream element (outlet) of a MINUHET layout can be a pipe, open 
channel, or pond.  The outlet may not be junction element. 
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5. The MINUHET Model Components 

5.1 Required information for creating a MINUHET model 
 
For developed watersheds, it is straightforward to plan the MINUHET schematic based on the 
planned storm sewer system and the development plans, if they are available.  It may be helpful 
to set up a spreadsheet containing a list of the sub-watersheds along with the area, slope, and 
length parameters of each. 
 
1) Determine the sub-watersheds and the drainage network for the system. 

 For developed watersheds, the sub-watersheds are usually based on the catch basins, e.g. 
each sub-watershed is defined as the area of land draining to a catch basin.  This 
information may be readily available from the storm sewer design itself. 

 For undeveloped watersheds, the network of tributaries that drain the watershed must be 
determined from topographic maps, digital elevation maps, or other resources.  Sub-
watersheds can then be defined on each side of the tributaries, with an assumed outlet 
point from the sub-watershed to the tributary at the midpoint of the downstream end of 
the sub-watershed.  

2)  Determine the area of each of the five land uses for each sub-watershed: Connected 
pavement, disconnected pavement, pervious, connected rooftop, and disconnected rooftop. 
3) Determine the characteristic length and slope of connected pavement and pervious areas.  The 
characteristic length is based on the longest flow path for the major features. 
 

5.2 The Sub-watershed Model 

5.2.1 The MINUHET surface runoff flow and temperature solver 
 
Land surface temperature model 
 
The land surface temperature model is based on a surface heat transfer model that calculates the 
radiation, convection, and evaporation components based on specified climate (Figure 2.1).  A 
one-dimensional finite-difference model is then used to calculate the vertical conduction of heat 
through the soil column and the soil temperature profile to a depth of one meter.  The MINUHET 
storm files include at least several days of antecedent climate conditions prior to the rainfall 
event, so that realistic surface temperatures and soil temperature profiles are calculated as the 
rainfall event begins.  Details of the surface temperature model are given in SAFL Technical 
Report #478 (Herb et al. 2006a).  A new feature of MINUHET version 2 is that the soil thermal 
properties (diffusivity, specific heat) are adjusted based on water content, using the relationships 
diffusivity and specific heat to volume fraction air given in Ochsner et al. (2001). 
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Figure 5.1.  Processes included in the MINUHET surface temperature model. 
 
 
Surface runoff model 
 
The surface runoff model was created for MINUHET to simulate runoff from relatively small 
impervious areas, e.g. a parking lot, at high time resolution, for steady or unsteady rainfall 
events.  The runoff model uses an analytic formulation to simulate the time history of flow rate 
and temperature at the outlet of an area with uniform slope (Figure 5.2).  The runoff model is 
based on Manning’s equations, a commonly used empirical equation relating flow rate and depth 
to slope and roughness for open-channel and surface runoff flows (Mays 2001).  
 

(5.1)  
n

yS
q

3/22/1

  

 
where q is the flow rate per unit width, S is slope, y is the flow depth, and n is Manning’s 
roughness coefficient.  The total length of the runoff area (L) is divided into a length, Le, that has 
fully developed (equilibrium) runoff flow and the developing flow length (L-Le), where the 
runoff thickness is assumed constant.  The length of the equilibrium flow region varies as a 
function of time based on previously developed expressions for the time to equilibrium (te) 
(Mays, 2001).   
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Based on the defined geometry, the total runoff volume per unit width (v) is given by: 
 

(5.3)   
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Based on conservation of mass, the rate of change of the total runoff volume can be expressed as: 
 

(5.4)  
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where i is the precipitation rate.  The MINUHET runoff model uses these basic equations to 
calculate the runoff rate and average runoff thickness as a function of time.  Because Manning’s 
equation is non-linear, finite-difference formulations are used.  The MINUHET runoff model is 
described in more detail in SAFL Project Report #494 (Herb et al. 2006d). 
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Figure 5.2.  Schematic diagram of the parameters used in the MINUHET runoff model. 
 
Runoff heat transfer 
 
A basic description of the runoff model is given here.  Further details can be found in Herb et al. 
(2009).An important component of the runoff model is the algorithm to calculate the heat 
transfer from the runoff to the land surface, as this has a major influence on the runoff 
temperature.  The heat transfer model assumes that the surface runoff, assumed to be initially at 
dew point temperature, and pavement surface must equilibrate to the same temperature over the 
time step (t), as shown in Figure 5.3.  To achieve this equilibrium, a convective heat flux Qro 
can be calculated, which draws heat out of a thin layer of pavement at the surface with thickness 
.  The size of  can be estimated from the thermal properties of the pavement and the time step, 
based on analytic solutions for heat conduction into an infinite slab subject to a change in surface 
temperature (Eckert and Drake, 1972). 
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(5.5)   t4   

 
where  is the thermal diffusivity and t is the time step.  An equation for the heat balance for 
the water film layer and the pavement may then be written as: 
 

(5.6)         sospproswpro TTc
2

TTcyQ 


  

 
where (cp)p and (cp)w are (density · specific heat) for the pavement and water, and the factor 
(/2) takes into account that the temperature change in the pavement decreases with depth, 
whereas the temperature change in the water film as assumed to be uniform across the thickness 
y.  If the dew point temperature and the initial surface temperature are known, Equation 5.6 can 
be solved for Ts. 
 

(5.7)   
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Using Equation 5.7, the heat flux from the pavement to the runoff may be calculated for each 
time step based on the total precipitation in each time step, and is simply added to the 
atmospheric heat flux components.  

Pavement

Surface Runoff

 Qro

h

D
ep

th

Tro TsoT(t)
D

ep
th

Ts T(t+Δt)

 
 
Figure 5.3.  Schematic of the formulation for heat transfer between surface runoff and the 
underlying pavement.  Example temperature profiles show the temperatures in the pavement 
prior to a rainfall event (T(t)) and after a rainfall event (T(t+t)), where the initial surface 
temperature (Tso) has equilibrated with the initial runoff temperature (Tro) to yield the new 
surface and runoff temperature (Ts). 
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Infiltration model 
 
MINUHET calculates soil infiltration for each time step during a runoff event using the Green-
Ampt algorithm (Mays 2001).  The Green-Ampt model is based on an estimate for the 
propagation of a wetting front through the soil column during a runoff event.  The rate of 
infiltration (f) depends on soil properties (saturated hydraulic conductivity (K), capillary soil 
suction (ψ)), the initial soil moisture content, and the cumulative depth of the wetting front (F) 
during the event.  During each runoff event, an incremental the depth of infiltration is calculated 
based on Equation 5.8: 
 

(5.8)   





 


F

F
Kf  

 
where  is the difference between the soil moisture content and the saturated moisture content.  
The solution to Equation 5.8 is obtained using a linearized solution form given by Li et al. 
(1976).  The use of the Green-Ampt model implies that the volume of runoff from pervious areas 
will depend on the chosen soil type and initial soil moisture content. 

5.2.2 The sub-watershed parameters 
A subwatershed represents an area of land that drains to a catch basin (in sewered watersheds) or 
a tributary (in unsewered/undeveloped watersheds).  Since the runoff from each sub-watershed is 
modeled as sheet-flow, the length of a subwatershed should be limited to about 100 meters (330 
ft).  In the MINUHET model structure, sub-watersheds are sources of stormwater runoff, so that 
flow is always routed out of a sub-watershed. 
 
The sub-watershed parameters are lumped into three major groups: Impervious, Pervious, and 
Rain Garden.  By default, the areas associated with each of these groups are set to zero.  Thus, 
the parameters for a particular group are used only if a non-zero area is specified for that group. 
 
The pavement area parameter gives the total area of connected pavement, including streets, 
driveways, and parking lots.  The Length parameter is based on the longest flow path for the 
major features (Figure 5.4).  The type parameter should be set to Asphalt or Concrete, based on 
the dominant pavement material for the impervious area being modeled.  The Shading parameter 
is used to estimate the level of solar shading from trees, buildings, and topography.  The 
additional area parameter is used to take into account roof areas draining onto the connected 
pavement.  In general, the additional area should not exceed 30% of the pavement area, since the 
treatment of runoff from the additional area is highly simplified.  Large connected roof areas, 
particularly commercial roofs, should be treated as a separate sub-watershed, as described in 
Section 5.3.4. 
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Figure 5.4.  Examples of the characteristic flow 
length for regular and irregular connected 
pavement areas. 
 

 

Table 5.1.  Subwatershed Parameter Values: Impervious 

Parameter Description Allowed Values 

Description An optional label or description of the area  

Area Area of connected streets, driveways, parking 
surfaces. 

10 – 100000 (m2) 

Length The maximum runoff travel distance. 2 – 1000 (m) 

Slope Average slope of the pavement area 0.001-0.2 (m/m) 

Shading Level of solar shading 0 – 100% 

Sheltering Level of wind sheltering 0 – 100% 

Land Use The dominant type of impervious surface asphalt, concrete, commercial 
roof, residential roof 

Connected Roof 
Area 

Connected roof area draining to connected pavement 1.– 10000 (m2) 

 

The parameters for a pervious area within a sub-watershed are summarized in Table 5.2.  The 
area, length, slope, shading, and sheltering parameters are defined in a similar manner to those of 
the impervious areas.  For pervious areas, the additional area parameter represents the area of 
rooftop and pavement draining into the pervious area.  The specified soil type has relatively little 
effect on surface and runoff temperature, but may significantly affect the quantity of runoff 
from the pervious area. 

Table 5.2.  Subwatershed Parameter Values: Pervious surface 
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Parameter Description Allowed Values 

Description An optional label or description of the area  

Area Total pervious area 10 – 100000 (m2) 

Length The maximum runoff travel distance. 2.0 – 1000.0 (m) 

Slope Average slope the pervious area 0.001-0.2 

Sheltering Level of wind sheltering 0 – 100% 

Shading Level of solar shading 0 – 100% 

Soil Type Soil type A,B,C,D 

Soil Moisture Soil moisture level prior to the storm event DRY, NOR (normal), WET 

Vegetation Density The density of the vegetation canopy. 

Dense lawn = 100% 

Row Crops = 60-100% 

Forest = 60-100% 

Prairie/Tall Grass =  95% 

0 – 100% 

Land Use The dominant or representative land use for the 
pervious area 

row crop, bare soil, forest, 
short grass, tall grass 

Disconnected Area Disconnected roof and pavement area draining to 
pervious area 

1 – 10000 (m2) 

 

Table 5.3.  Hydraulic and thermal soil parameters corresponding to USDA soil types A-D. 

USDA Soil Type A B C D 

Saturated  Thermal 
Diffusivity (m2/s) 

8.5E-07 8.5E-07 8.5E-07 8.5E-07 

Saturated  Specific Heat 
(J/m3/ºC) 

3.0 3.0 3.0 3.0 

Maximum water content 
(water volume fraction) 

0.442 0.462 0.398 0.464 

Field Capacity (water 
volume fraction) 

0.141 0.30 0.255 0.361 

Wilting Point (water 
volume fraction) 

0.061 0.125 0.148 0.233 

Saturated Hydraulic 
conductivity (m/s) 

2.75E-05 2.98E-06 1.19E-06 3.61E-07 

Soil Suction (m) 0.10 0.16 0.28 0.32 

Brooks/Corey Exponent 2.3 4.65 4.0 6.64 
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5.2.3 Setting the Sub-watershed Parameters for a Residential Development 
 
For residential developments, it is typically not practical to define separate sub-watersheds for 
each area of pavement, rooftop, and pervious area.  As a result, the MINUHET tool incorporates 
features to lump multiple houses into a single subwatershed.  Each sub-watershed may contain a 
combination of pervious and impervious surface areas: up to five areas of different land use can 
be specified (Figure 6.1): 
 
(1) The total area of connected pavement, e.g. driveways, streets, and parking areas 
(2) The total area of disconnected pavement, e.g. pavement drained into pervious areas. 
(3) The total surface area of the rooftop drained into connected pavement, e.g. driveways 
(4) The total surface area of the rooftop drained into pervious areas (lawns, other vegetation) 
(5) The total area of the pervious land 
 
No attempt is made to represent the detailed shapes and location of each area within the 
subwatershed.  The connected pavement area and the impervious area are represented as an area 
and a characteristic length. 
 
Thermo-hydrographs (water flow and temperature time series) are simulated using the runoff 
model for each subwatershed, based on the selected storm event and the subwatershed 
characteristics.  For each subwatershed, two separate thermo-hydrographs will be calculated for 
the connected impervious area and for the pervious area.  The two thermo-hydrographs will then 
be combined (mixed) to give a single flow and temperature for each subwatershed using a simple 
mixing FORTRAN executable (Figure 5.6). 
 

(2) Disconnected 
Pavement

(1) Connected Pavement

(5) Pervious

Catch
Basin

(3) Connected 
Rooftop

(4) Disconnected 
Rooftop

 
 
Figure 5.5.  Schematic of developed sub-watershed, showing the five land use types and their 
hydraulic connectivity.  For each sub-watershed, one (upper diagram) or two (lower diagram) 
areas of connected pavement may be defined. 
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Figure 5.6.  Flow chart of the simplified model for each sub-watershed. 
 
For sewered developments, it is typically a good strategy to define one sub-watershed for each 
catch-basin.  However, if a catch-basin receives flow from two or more directions with distinct 
length scales, multiple sub-watersheds can be defined.  The outputs of the sub-watersheds should 
then be connected with a junction element to feed the combined flow into a single sewer pipe, as 
shown in Figure 5.7. 
. 

sws01 sws02Catch 
Basin

Outlet 
pipe

Figure 5.7.  Schematic of a catch basin receiving flow from two sub-watersheds (sws01 and 
sws02) and the corresponding MINUHET layout to handle this case, using two sub-watershed 
elements and a junction to model the combined flow to the outlet pipe. 
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Vegetation Effects 
 
The effect of vegetation on surface runoff and heat transfer can be included at several different 
levels in the MINUHET model: 
 
1)  A vegetation type is specified for each pervious area within a sub-watershed.  The hydro-
thermal runoff model then includes the effect vegetation on the surface temperature prior to the 
storm, the runoff temperature during the storm, and the surface roughness for runoff rate 
calculations. 
 
2) For both pervious and impervious areas with a sub-watershed, a shading coefficient may be 
specified.  This coefficient (0 – 100%) represents the amount of solar shading from intermittent 
tree cover, e.g. boulevard and other landscaping trees, buildings, and topography (hills).  Setting 
a non-zero shading coefficient reduces the amount of solar radiation that reaches the land 
surface.  Setting the coefficient equal to 100% implied complete shading, i.e. no solar radiation 
reaches the land surface. 
 
3) For both pervious and impervious areas with a sub-watershed, a sheltering coefficient may be 
specified.  This coefficient (0 – 100%) represents the amount of wind sheltering from 
intermittent tree cover, e.g. boulevard and other landscaping trees.  Setting a non-zero shading 
coefficient reduces the wind velocity used in surface heat transfer model.  Setting the coefficient 
equal to 100% implied complete sheltering, i.e. there is no wind at the land surface. 
 
It is quite possible for the pervious area of a sub-watershed to have both 1) a vegetated land use, 
e.g. short grass, and 2) some level of additional sheltering and shading from tree cover.  
However, adding tree cover to a pervious land use will have relatively little effect on runoff 
quantity and temperature.  Adding tree shading to an area of pavement may significantly reduce 
the surface temperature prior to the onset of rainfall, and thus may reduce runoff temperature. 
 
Determining % Shading 
Shading can be estimated via site visits or aerial photographs.  The % shaded land area should be 
determined for the period of time approximately 2 to 4 hours prior to the onset of rainfall, e.g. 
mid-day shading if the design storm occurs in the afternoon.  Typically, tree shading is more 
significant for narrow pavement features (streets, sidewalks) and less significant for wide areas 
such as parking lots. 

5.2.4 Setting the Sub-watershed Parameters for a Commercial Development 
 
Sub-watersheds with commercial buildings may require a different strategy compared to 
residential developments.  It may be appropriate to define separate sub-watersheds for the 
building roof and parking lot, since these areas often have their own sewering in large 
commercial buildings.  If the building roof is defined as separate sub-watershed, then the primary 
impervious surface area is set to type commercial roof.  A large parking lot for a commercial 
building may require several sub-watersheds, which may be defined based on the locations of the 
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catch basins.  An example of a MINUHET model for a commercial building is given in Figure 
5.8. 

Pavement
Area

Pervious
Area

Roof
Area

Sub-watershed 1

Pavement
Area

Pervious
Area

Sub-watershed 2 Sub-watershed 3

Junction

Infiltration Pond

Pipe

Pipe

Pipe

Pipe

 
Figure 5.8.  Schematic showing the components of a model for a commercial building and 
parking lot. 
 

5.3 The Routing Network 

5.3.1 The MINUHET routing network flow and temperature solver 
A basic description of flow and heat routing solver is given here.  Further details can be found in 
Herb et al. (2009).  The basic problem of the routing solver is to solve for the flow rates and 
temperatures at each node in the drainage network , based on the flow inputs from the sub-
watersheds (Figure 5.9).  The flow rate through the drainage network is calculated first, using 
Manning’s Equation and a non-linear kinematic wave formulation (Chow 1976).  The equation 
of continuity at any point in the flow is: 
 

(5.9) lq
t

A

x

Q
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where Q is the flow rate, x is the streamwise coordinate, A is the cross-sectional area of the flow, 
t is time, and ql is a specified lateral inflow rate per unit length.  Equation 5.9 has 2 unknowns, 
flow and area, however, flow can be related to area through Manning’s equation: 
 

(5.10) 
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where S is slope, n is Manning’s roughness coefficient, ad P is the wetted perimeter of the flow 
cross-section. Combining Equations 5.9 and 5.10 produces a single, non-linear equation for flow. 
 

(5.11) l
1 q

t

Q
Q

x

Q







   

 

where n/S and b is a constant that depends on the geometry of the flow conduit.  Equation 
5.11 is solved for each pipe or channel section using finite-difference formulations given in 
Chow (1976). 
 
The flow solver assumes no backwatering effects, i.e. the pipes do not reach full capacity.  For 
open channels, the trapezoidal cross section has no inherent depth limit. 
 
After the flow solution is completed, the temperature at each flow node in the network is 
calculated, beginning with the known inflow temperatures from the sub-watersheds.  For each 
pipe or open channel, the downstream temperature is calculated using the Equation 5.12 based on 
a heat balance (Figure 5.10): 
 

(5.12)   )TT(AHLBhTQTQTV
t wwwaoutoutinin 



 

 
where T is temperature, V is the water volume in the pipe segment, Hw is the wall heat flux, Aw 
is the wetted area in the pipe, Tw is the temperature of the pipe wall, ha is the atmospheric heat 
transfer rate (W/m2), B is the top width of the flow, L is the reach length.  The wall heat transfer 
is calculated using the same method that is used to calculate surface runoff - land surface heat 
exchange (Section 5.2.1).  An increasing thermal boundary layer thickness in the pipe wall and 
soil is estimated as a function of time, starting at the onset of a flow event.  As a result, wall heat 
transfer is highest at the start of the flow event. 
 
 



 26

Q1, T1 Q3, T3

Q5, T5

Q2, T2 Q4, T4

 

Qin , Tin

Qout, Tout

Hw = Wall heat 
transfer

 
Figure 5.9.  Schematic of a simple drainage 
network with two inflows from sub-
watersheds. 

Figure 5.10.  Schematic of the heat balance on 
a single pipe segment. 

 
 

5.3.2 MINUHET Routing Elements 
 
MINUHET has several routing elements to specify a natural or man-made drainage network and 
routs stormwater runoff from sub-watersheds.  MINUHET uses a kinematic wave algorithm to 
simulate the flow of water and heat through the drainage network.  In its current configuration, 
MINUHET does not include atmospheric heat transfer for the routing elements, so that it is not 
appropriate to simulate long open channel drainage networks.  The routing model does not 
include junction losses, so that MINUHET should not be used as a tool for designing stormwater 
handling systems.  The routing model can handle up to 256 routing elements.  There are four 
types of routing elements available for simulation of a drainage network: 
 
1. Pipes:  Circular storm sewer pipes.  No infiltration is included in the flow calculation, but heat 
transfer from the stormwater to the pipe wall is included in the temperature calculations.  A mean 
depth of the pipes beneath the land surface is specified a global parameter for the routing model.  
This depth is used to estimate an initial pipe wall temperature. 
 
Pipe elements may also be used to simulate culverts, but effects such as entrance losses and 
back-watering are not considered.  For culverts with substantial upstream or downstream 
pooling, the pond model element with a pipe outlet may be more appropriate.   
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2. Impervious open channels: Concrete open channels with trapezoidal cross section.  No 
infiltration is included in the flow calculation. 
 
3. Pervious open channels:  Vegetated or bare soil open channels with trapezoidal cross section.  
Infiltration is included, at a rate based on the specified soil type.  Swales can be modeled using 
the pervious open channel elements.  Pervious open channels can include specification of a 
distributed groundwater inflow. 
 
4. Junction Elements:   Junction elements are used to represent any point where two or more 
flows are combined, including pipe junctions, catch basins, and channel junctions.  A junction 
element may have up to five inputs from pipes and/or sub-watersheds, but has only 1 output.  As 
a result, flow splitting is not currently implemented in MINUHET. 
 

5.3.3 Setting the parameters for routing elements 
 
Routing elements are used in MINUHET to create the stormwater drainage network.  The 
drainage network may consist of storm sewer pipes, pervious channels (tributaries, gullies, 
swales, and ditches), impervious open channels (e.g. concrete-lined channels), or some 
combination of these elements.  The connectivity of the routing elements and the flow direction 
through the routing elements are completely determined from the schematic layout, therefore the 
main task described here is to set the lengths, slopes, roughness, and cross-section geometry of 
the routing elements. 
 
All routing elements require a length-wise slope, where the element is assumed to slope 
downward in the direction of flow.  The slope should always be specified as a positive number. 
Specification of a zero or negative slope will result in a solution error. 
 
Pipe Elements: For MINUHET pipe elements, the length, inside diameter, length-wise slope 
(vertical/horizontal), the Manning’s roughness, and the depth of the pipe invert beneath the land 
surface are specified.  Guideline values for setting Manning’s roughness are given in Table 5.4 
for common pipe materials. 
 
Open Channel Elements: Open channel elements are assumed to be impervious, i.e. no 
infiltration of runoff is calculated.  As with pipe elements, the length, length-wise slope 
(vertical/horizontal), and Manning’s roughness are specified. The cross-section of open channels 
is constant over the length of each element, and is specified with the width and side-slope 
parameters (Figure 5.11). 
 
Pervious Open Channel Elements:  MINUHET pervious open channel elements have the same 
geometric specifications as open channel elements, but include additional features to model 
infiltration through the channel bottom: the soil type (USDA A,B,C,D), and the initial soil 
moisture content (Dry, Normal, or Wet).  As with the sub-watershed model, the infiltration rate 
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is calculated using the Green-Ampt equation (Equation 5.8).  A distributed groundwater inflow 
rate and temperature can be specified. 
 
Junction Elements:   As implemented in MINUHET, junction elements act simply to combine 
inflows, with no energy loss mechanisms or storage.  As a result, junction elements have no 
parameters to specify except for an optional description. 
 
 
Table 5.4  Manning’s roughness coefficient (n) for open channel flow.  All values are taken from 
Mays (2001). 
Material n 
Asphalt 0.01-0.015 
Bare soil 0.02-0.023 
Grass, Bermuda 0.045-0.25 
Grass, bluegrass sod 0.03-0.10 
Concrete 0.01-0.013 
Corrugated metal 0.022-0.037 
Gravel 0.012-0.030 
Grouted riprap 0.028-0.040 
Stone masonry 0.03-0.042 
 
 
 
 
 

Side slope = 
Δh/Δv

Width

Δh
Δv

Figure 5.11. Cross-sectional parameters for 
MINUHET open channel elements. 
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5.4  The MINUHET Pond Model 

5.4.1 Pond model description 
 
The MINUHET pond model can be used to simulate wet detention ponds, infiltration ponds and 
rain gardens, and dry ponds.  The purpose of the pond model is to simulate the pond response 
(outflow rate and temperature) to stormwater inflow events.  The outflow rate and temperature 
depend on both the initial condition of the pond prior to the event (stage, temperature) and the 
characteristics of the inflow event.  The processes considered in the MINUHET pond model are 
illustrated in Figure 5.12. 
 
The pond model is based on previous 1-D models for lakes (Ford and Stefan 1980, Hondzo and 
Stefan 1993) and wastewater detention ponds (Gu and Stefan 1995).  The model divides a 
detention pond into a system of horizontal water layers, and simulates the time-variable water 
temperature as well as in- and outflow rates for each layer. Given the geometry of all storm 
sewers discharging to a pond, the hydrology of the inflows, and the design of any outlet 
structure, the model projects the rate and temperature of the outflow from the pond.  The pond 
vertical temperature profile is calculated for each time step based on atmospheric heat transfer, 
heat conduction through the pond bottom, and the flow rate and temperature of inflows.  
Atmospheric heat transfer includes solar and long wave radiation components, atmospheric 
convection, and evaporation.  Pond level is calculated based on inflow and outflow rates, 
infiltration, direct precipitation, and evaporation.  Inflow calculations include a simple jet 
entrainment model and a model that determines the depth to which the inflow plunges.  Pond 
outflow calculations include an estimate of the range of depth from which water is drawn to the 
outlet, to better estimate the outlet temperature.  Each pond may be connected to up to five 
inflows from pipes or open channels.  A number of outflow types may be specified for each pond 
element.  Further details on the MINUHET pond model may be found in SAFL Project Report 
#479 (Herb et al 2006b). 

5.4.2 Setting the pond parameters 

The bathymetry of the pond is specified by clicking on the Collection field next to the 
Bathymetry label, and then clicking on the …  icon, which opens a pop-up table.  Click on the 
“Add” button to add each pair of (Elevation, Area) data points.  Click on “Ok” when all the 
bathymetry data have been entered.  The (Elevation, Area) pairs will be listed on the left side of 
the pop-up window, but the values are not updated until the table is closed and re-opened. 

The Secchi depth determines the mean water clarity for the pond.  The main effect of varying 
Secchi depth is to change the degree of temperature stratification prior to the storm event. 

For ponds, the infiltration rate at the pond bottom is set directly using the infiltration rate 
parameter, rather than specifying a soil type.  The initial elevation parameter is important to 
specify, because it determines the degree of storage available at the start of the storm event.  The 
reference elevation is the elevation of the pond bottom. 
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Figure 5.12.  Schematic of the pond model hydraulic (top) and thermal (bottom) processes. 

 

Modeling a Wet Detention Pond 

To use the MINUHET pond model to simulate a wet detention pond, the infiltration rate 
parameter is typically set to a low value (e.g. 1 cm/day or less), and the vegetation density 
parameter is typically set to a low number (0 -10 %).  The initial pond elevation may be set, e.g., 
to be equal to the outlet elevation, so that any stormwater inflow will produce an outflow from 
the pond.  Setting a lower initial pond elevation will give the wet pond some storage capacity, 
and reduce thermal loading from the pond outlet.  The pond model parameters are summarized in 
Figure 5.13 and Table 5.5.  Shading can be estimated via site visits or aerial photographs, and 
should be estimated as the average % surface area that is shaded, on average, for the period 9 am 
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and 5 pm.  Emergent vegetation surrounding the edge of a pond, e.g. in the shallow safety bench 
area, is expected to have little effect on the temperature of water in the deep area of a pond. 

 

Modeling an Infiltration Basin, Rain Garden, or a Dry Detention Pond 

To use the MINUHET pond model to simulate an infiltration pond, the infiltration rate parameter 
is typically set to a higher value (e.g. 10 - 100 cm/day), and the vegetation density parameter is 
typically set to a high number (70 -90 %), assuming that healthy vegetation exists in the pond. 
The initial pond elevation may be set to be zero for an infiltration pond, dry detention pond, or a 
rain garden.  If the rain garden contains an engineered soil layer with significant volume, the 
pore volume of the engineered soil should be included in the bathymetry of the pond model.  The 
infiltration rate parameter should be set based on the soil beneath the engineered soil layer.  For 
storms of moderate length, this infiltration rate will likely have minimal effect on flow volume 
and temperature from the outlet of the pond. 

 

Specifying the outlet structures for a pond 

Six types of outlet structures can be specified for each pond.  Up to two outlet types may be 
specified for each pond, e.g. an orifice discharge to establish normal stage plus a broad-crested 
weir for overflow.  If a pipe or open channel element is connected to downstream of the pond 
element, the total pond outflow is routed to the single pipe or channel element, i.e. it is not 
possible to rout the flow from two different pond outlet structures to separate pipe elements.  
Table 5.6 gives the six pond outlet types that may be specified and the associated parameters for 
each type. 

or each outlet structure, the control elevation and the withdrawal elevation can be separately 
specified.  A pipe outlet may be specified in a normal configuration, with the pipe sloping away 
from the pond outlet (inflow elevation > outflow elevation), or as a submerged outlet pipe(inflow 
elevation < outflow elevation), as shown in Figure 5.14.  Similarly, an orifice outlet in a box 
outlet structure can specified in a standard configure, where the surface water is taken 
(withdrawal elevation=control elevation), or with a submerged withdrawal (control elevation < 
withdrawal elevation), as illustrated in Figure 5.15.  Weirs are typically specified with 
withdrawal elevation = control elevation.  Parameters for a v-notch weir are illustrated in Figures 
5.16. 
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Figure 5.13.  Typical input parameters for a wet detention pond, including bathymetry, and the 
elevations of the outlet structures. 
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Figure 5.14.  Schematic diagram of a wet pond with a pipe outlet in a standard configuration 
(top) and a submersed intake configuration (bottom). 
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Figure 5.15.  Schematic diagram of a wet pond 
with a box outlet structure in a standard 
configuration (top) and a submersed intake 
configuration (bottom).  
 

Figure 5.16.  Parameter specifications for a 
v-notch weir outlet structure. 

Table 5.5.  Pond Parameters 

Parameter Description Allowed Values 

Description An optional description of the 
pond 

 

Bathymetry meter (elevation), square 
meters (area) 

Elevation = 0 -2000 
Area = 0 – 40,000 

Infiltration Rate cm per day 0 - 100 
Initial Elevation meters 0 - 2000 
Secchi Depth meters 0.1 - 10 
Shading percent 0 – 100% 
Sheltering percent 0 – 100% 
Vegetation Density The average coverage of 

emergent vegetation. 
0 – 100% 

Outflow1 
Outflow2 

see Table 5.6 
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Table 5.6.  Pond outflow (outlet) structure types and associated user-specified parameters 

Outlet Type Parameters (units) 
 

Sharp-crested weir Length (m): Total weir linear length 
Control Elevation (m) 
Withdrawal Elevation (m) 

Broad-crested weir Length (m): Total weir linear length 
Control Elevation (m) 
Withdrawal Elevation (m) 

V-notch Weir Notch Angle (degrees): See Figure 5.16 
Width (m): See Figure 5.16 
Control Elevation (m) 
Withdrawal Elevation (m) 

Pipe Diameter (m):  Pipe inside diameter 
Length (m) 
Roughness (Dimensionless Manning’s roughness) 
Inflow Elevation (m) 
Outflow Elevation (m) 

Orifice Diameter (m) 
Control Elevation (m) 
Withdrawal Elevation (m) 

User-specified stage-
discharge relationship 

Table of Elevation (m), Discharge (m3/sec) data 
Withdrawal Elevation (m) 

 

5.5   Modeling Rain Gardens 
 
Rain gardens can be handled in MINUHET at two levels.  
 
1)  Small rain gardens that are internal to a sub-watershed can be specified within each 
subwatershed element.  Adding a rain garden volume to a sub-watershed effectively increases the 
amount of surface storage in the pervious area, so that more rainfall is stored prior to the onset of 
runoff.  These small rain gardens are assumed to affect runoff quantity, but not runoff 
temperature. 
 
2) Larger rain gardens that are external to a sub-watershed can be included using the pond 
model.  The rain garden storage volume is set using the pond bathymetry, an infiltration rate is 
specified for the underlying soil, and the initial water depth can be specified to be zero, assuming 
the rain garden is designed properly. 
 
For both cases, the rain garden volume is calculated as the above ground storage volume plus the 
pore volume of the engineered soil layer (Figure 5.17).  For case 1, the total rain garden storage 
volume (Vtot) is input directly in the sub-watershed attributes.  The infiltration rate of the 
underlying native soil is set automatically in MINUHET, based on the soil type selected for the 
pervious area.  For case 2, the storage volume of the engineered soil can be included in the pond 
bathymetry definition, if it adds significantly to the above ground storage volume.  Since the 
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effect of the engineered soil is included in the pond bathymetry, the infiltration rate should be set 
to be a suitable value for the underlying native soil. 
 

Vtot = Vag + Vsoil

Ves= h·A·n

h = thickness of engineered soil

A = rain garden area

n = porosity of engineered soil

i = infiltration rate of native soil

Vag

i

Native soil

Engineered soil

Vtot = total storage volume of 
rain garden

Vag = above-ground storage 
volume of rain garden

Ves = pore space volume of 
engineered soil  

 
Figure 5.17 Schematic showing the components of total storage volume in a rain garden. 

6. Modeling Undeveloped Watersheds 
Stormwater runoff from undeveloped land parcels can be modeled using MINUHET.  The most 
challenging task in modeling undeveloped watersheds is determining the drainage network.  
Ideally, the size of the sub-watersheds and the drainage network of open channel tributaries are 
chosen in the model so that the sub-watersheds are dominated by sheet flow runoff processes, 
while the channel elements represent the places where the runoff becomes channelized.  The 
current version of MINUHET does not consider distributed lateral inflow to channels, therefore 
the channel nodes should be placed at representative locations relative to the sub-watershed 
areas. 

Figure 6.1 gives an example of an undeveloped land parcel with the sub-watersheds and 
tributaries delineated.   
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Sub-watershed

Tributary 
segment

 
Figure 6.1.  Typical sub-watershed boundaries and inflow points to a tributary in a small, 
undeveloped watershed (left panel) and the corresponding MINUHET schematic using five 
sub-watersheds and three open-channel elements. 
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7. Running a MINUHET simulation 

7.1 Selecting a storm event 
 
The climate database in MINUHET includes both continuous climate data for different regions 
of Minnesota (Figure 7.1) and a number of individual storm events.  The storm selection process 
moves from left to right in the Region/Storm Selection menu (Figure 7.2): 
 
1. The user selects a county from the in the Region/Storm Selection menu. 
2. Based on the selected county, MINUHET determines the appropriate climate region, which is 
displayed, but not editable, in the Region/Storm Selection menu. 
3. At least one year of continuous climate data and a number of individual storms are then 
available for selection. The user chooses a storm or climate data set by clicking on the icon on 
the far right of the Region/Storm Selection menu.  A small window pops-up, with checkboxes 
next to the list of available storms and continuous climate data. 
4. A default start and stop time are display, which can be edited.  This feature is primarily to 
allow the user tp select a range of climate data in the continuous climate files.  It is suggested 
that the start/stop times not be changed by the for the individual storm events. 
 

Figure 7.1. Map of Minnesota and the seven climate regions used in 
the simulation tool. 
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Figure 7.2. Region/Storm Selection menu in the pre-processor. 
 

 
 
Figure 7.3. Storm selection pop-up window. 
 
The current design storm set includes two observed design storms and three synthetic design 
storms, as summarized in Table 7.1.  The observed storms (Observed01 = June 20, 2005 and 
Observed02 =August 16, 2005) are taken from 15 minute climate data set from the MnROAD 
facility in Albertville, MN, and are shown in Figure 7.4.  Both storms have the potential to 
produce high thermal impact, i.e. the combination of runoff temperature and runoff volume. 
 
Synthetic storms 1 and 2 are both 1 hour duration events.  The climate data prior to and after the 
actual storm are taken from the MnROAD climate data set for period July 20 – August 2, 1999, 
which included a rainfall event at 16:00 hours on July 30.  With the rainfall fixed at 1 hour, the 
precipitation quantity and dew point temperature during the storm were adjusted to produce 
storms of 1 and 10 year return period for total heat export (Table 7.1), with the resulting 
hyetographs shown in Figure 7.5. 
 
Synthetic storm 3 is a 2 year recurrence, 24 hour duration storm event.  The precipitation is 
distributed over 24 hours according to the SCS Type II distribution (Figure 7.6).  Solar radiation 
during the storm event is based on the observed relationship between solar radiation and 
precipitation rate.  More details on this storm event can be found in Herb (2008). 
 
Continuous climate data sets are also included for the seven climate regions.  These data are all 
observed climate data for either 2005 or 2008, from various sources, as summarized in Table 7.2. 
Wherever possible, data were obtained that included observed solar radiation, because solar 
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radiation is crucial in determining runoff temperatures.  Several data sets use simulated solar 
radiation, obtained from the National Renewable Energy Lab (NREL). 
 
Antecedent Conditions 
 
All individual storm events include one week of antecedent climate.  At the start of a MINUHET 
analysis, surface temperature, soil temperatures, and pond temperatures are estimated based on 
the time of year.  Running the model for several days prior to the storm of interest allows the 
various estimated temperatures to adjust to more accurate values for the particular soil types, 
moisture conditions, etc. in each model.  Figure 7.7 gives the antecedent climate data used for the 
synthetic storms, currently data from the MnROAD facility in Albertville, MN, July 24 – July 
30, 1999.  Figures 7.8 and 7.9 give the antecedent climate for the observed storms on 6/20/2005 
and 8/16/2005. 
 
 
 
Table 7.1.  Summary of observed design storms and synthetic design storms. 
Name Return 

Period 1 
Date Start Time Duration 

(hours) 
Average Dew 
Point (°C) 

Total Precip 
(cm) 

Observed01 3.2 6/20/05 11:30 2.3 18.3 3.8 
Observed02 3.7 8/16/05 16:30 4.0 16.6 1.1 
Synthetic01 1 7/30/99 16:00 1.0 17.0 1.5 
Synthetic02 10 7/30/99 16:00 1.0 18.5 7.5 
Synthetic03 2 7/30/99 00:00 24.0 20.0 7.1 

 
1.  The return period listed is based on total heat export from an asphalt surface (see SAFL 
Project Report #483, Herb et al. 2007).  For the synthetic storms, the precipitation depth also 
corresponds to the return period for the Minneapolis/St. Paul region. 
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Table 7.2.  Continuous climate data sets. All data sets from from June 15 to September 15. 
Climate Region Year Climate Station Site Time Resolution Solar Data 
I 2005 U of M St. Paul Campus 1 1 hour Observed 
II 2005 Rochester, MN Airport 2 1 hour Modeled 
III 2008 Aurora, SD 3 1 hour Observed 
IV 2008 Albertville, MN 

(MnROAD facility) 4 
1 min Observed 

V 2008 Mavie, MN 5 1 hour Observed 
VI 2005 International Falls, MN 

airport 2 
1 hour Modeled 

VII 2008 Duluth, MN 6 15 min Observed 
 
1. Data were obtained from Dr. David Ruschy at the St. Paul Climatology Office. 
http://climate.umn.edu/doc/observatory.htm 
2. Observed climate data and modeled solar radiation from the NREL web site: 
http://rredc.nrel.gov/solar/old_data/nsrdb/1991-2005/ 
3. Data obtained from the South Dakota State University: 
http://climate.sdstate.edu/climate_site/archive_data.htm 
4.  Data supplied by MnDOT 
5.  Data obtained from the North Dakota Agricultural Weather Netowrk: 
http://ndawn.ndsu.nodak.edu/  
6. Precipitation, air temperature, and relative humidity data from a weather station in the Miller 
Creek watershed, supplied by the South St. Louis Soil and Water Conservation District.  Wind 
data obtained from the Duluth International Airport.  Observed solar radiation data from Lincoln 
School, in the Miller Creel watershed, supplied by the Minnesota Pollution Control Agency.



 41

0

10

20

30

40

50

60

0:00 4:00 8:00 12:00 16:00 20:00 0:00 4:00

Time

T
e

m
p

e
ra

tu
re

 (
C

),
 S

o
la

r 
 (

W
/m

2  x
 0

.0
5

)

0.0

0.2

0.4

0.6

0.8

1.0

1.2

1
5

 m
in

 P
re

c
ip

 (
c

m
)

Air Temp

Dew Point

Solar

Precip

8/16/2005

 

0

10

20

30

40

50

60

0:00 4:00 8:00 12:00 16:00 20:00 0:00 4:00

Time

T
em

p
e

ra
tu

re
 (C

),
 S

o
la

r 
 (

W
/m

2  x
 0

.0
5

)

0.0

0.5

1.0

1.5

2.0

2.5

1
5

 m
in

 P
re

c
ip

 (
c

m
)

Air Temp

Dew Point

Solar

Precip

6/20/2005

 
Figure 7.4.  Detailed 15 minute climate data (Air and dew point temperature, solar radiation, and 
precipitation) for the two observed storm events (6/20/05 and 8/16/05) included with 
MINUHET. 
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Figure 7.5.  Detailed 15 minute climate data (Air and dew point temperature, solar radiation, and 
precipitation) for the one year (lower panel) ten year upper panel) synthetic storm events 
included with MINUHET. 
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Figure 7.6.  Detailed 15 minute climate data (Air and dew point temperature, solar radiation, and 
precipitation) for the 2 year 24 hour synthetic storm events included with MINUHET.  Air 
temperature = dew point temperature = 20 °C for this storm. 
 



 44

10

15

20

25

30

35

7/16/99 7/18/99 7/20/99 7/22/99 7/24/99 7/26/99 7/28/99 7/30/99 8/1/99

T
e

m
p

er
at

u
re

 (
C

)

Air Temp
Dew Point

 

0

200

400

600

800

1000

1200

7/16/99 7/18/99 7/20/99 7/22/99 7/24/99 7/26/99 7/28/99 7/30/99 8/1/99

Date/Time

S
o

la
r 

R
ad

ia
ti

o
n

 (
W

/m
2
)

 
Figure 7.7  Observed air temperature, dew point temperature, and solar radiation for July 19 to 
August 2, 1999 at the MnROAD facility in Albertville, MN.  The data are used for the 
antecedent climate data for the synthetic storm events.
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Figure 7.8  Observed air temperature, dew point temperature, and solar radiation for June 7 to 
June 22, 2005 at the MnROAD facility in Albertville, MN. 
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Figure 7.9.  Observed air temperature, dew point temperature, and solar radiation for August 2 to 
August 18, 2005 at the MnROAD facility in Albertville, MN. 
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7.2 Running a Simulation 
 
With the schematic layout completed and a storm event is selected, an MINUHET hydro-thermal 
runoff simulation may be initiated by selecting Simulation → Run from the drop-down menu at 
the top of the MINUHET window.  If the simulation is successful, the Simulation Run Browser 
window will appear, described in the Chapter 8.  If the simulation is not successful, a message 
window will appear with information about the run error, described in the troubleshooting 
section (Chapter 10). 
 
Note: By default, the project file is saved prior to each simulation, so that any recent edits to the 
model schematic and element properties are updated. 
 

 

 

8. Viewing the results: The MINUHET Simulation Run 
Browser 
 
The MINUHET Simulation Run Browser (SRB) performs all the post-processing functions for 
the system, allowing the user to view the simulation results and export the results to word 
processing files, spreadsheets, etc.  The SRB is opened automatically when a simulation is run, 
but may also be accessed at any time from the MINUHET main window by selecting Tools → 
Simulation Run Browser from the drop-down menu.  Once opened, the SRB can be used to view 
the current or previous simulation results for the current model. 
 
The components of the MINUHET SRB are illustrated in Figure 8.1.  Areas of the SRB window 
include the Simulation History, the Schematic, the Element Properties Area, and the Graphing 
window.  The SRB also has a small drop-down menu at the top of window. 
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Figure 8.1.  The MINUHET Simulation Run Browser (SRB). 
 
 
The Simulation History gives a selectable, chronological list of all the simulations that have 
been run for current model.  Each simulation run may include one or more storm events.  
Selecting a simulation run and a storm event from the history makes the simulation results for 
that storm available for display in the SRB.  The simulation runs are named with the model 
name, followed by the date and time that the simulation was run.  The Schematic window 
displays the model schematic.  When a simulation run and storm are selected, the simulation 
results are displayed for the farthest downstream point of the system.  Simulation results may be 
display for other points in the system by selecting elements in the schematic.  Flow rate and flow 
temperature may be displayed for the outlet of any sub-watershed, pipe, open-channel, or pond.  
For example, selecting a pipe element in the schematic causes the flow rate and temperature at 
the outlet of that pipe to be displayed in the Graphing window.  As an element is selected, its 
properties are displayed, but not editable, in the Element Properties Area.  If the schematic is too 
large to be displayed in the Schematic window, a scroll bar will appear that can be used to move 
around to different areas of the schematic. 
 
Note that if the model schematic was modified between subsequent simulation runs, the SRB 
automatically loads in the correct version of the model schematic for display along with the 
simulation results for the selected simulation. 
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The Graphing Window displays the time history of flow rate and flow temperature for the 
chosen point in the model. 

 If a sub-watershed is selected, average surface temperature is plotted when flow is zero, 
and runoff temperature is plotted when flow is non-zero. 

 If a pipe or channel is selected, the pipe wall temperature is plotted when the flow rate is 
zero. 

 If a pond is selected, the pond water surface temperature is plotted when the outflow rate 
is zero. 

 
The Graphing Window includes several useful functions that are accessed with the left and right 
mouse buttons.  The user can zoom-in one the graph by clicking and dragging the left mouse 
button.  Clicking the right mouse button within the graph enables the following functions: 
 

 Copy:  copies the graph to the clipboard.  The graph image can then be pasted in other 
documents (MS Word™, MS Powerpoint™, etc.).  This function may also be accessed 
using the Graph → Copy to Clipboard function in the drop-down menu. 

 Save Image As:  saves an image file of the graph to a user-defined file name/location, in 
Png, Gif, Jpeg, Tiff, or Bmp format. 

 Page Setup: Used to set the printing page parameters 
 Print:  Print the graph 
 Show Point Values:  Enabling this feature cause the numerical values of flow, 

temperature and time to be displayed in a small box as the mouse is moved over the 
graph. 

 Un-zoom: Go back one zoom step 
 Undo All Zoom/Pan: Undo all zoom steps 
 Set Scale to Default: Similar to Undo All Zoom/Pan, but resets the vertical scales to even 

increments of flow/temperature. 
The graphing window includes summary data on the right side: average runoff temperature, total 
runoff volume, total heat export, and total precipitation.  These data are calculated for the data 
that are displayed in the graphing window, and are therefore updated if the zoom feature is used. 
 
The SRB drop-down menu has several useful commands: 
 
File → Export Graph Data: This function is used to export the time, flow rate, and flow 
temperature data to a comma-delimited (.csv) file that is easily loaded into MS Excel™, for 
example.  The csv data file will include the full time series for the selected element in the 
schematic. 
File → Export Case File:  This function can be used to export the Case File (see Section 3) for 
the selected simulation run.  This function can be used in conjunction with the Simulation 
History to extract an older version of the current model and create a new model. 
File → Close:  Used to close the Simulation Run Browser 
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View→ Summary Table:  Used to open the Summary Table (Figure 8.2), which gives a table of 
top level results (average runoff temperature, total heat export, total runoff volume) for elements 
of the model.  The table entries can be coped and pasted to a spreadsheet, or the entire table can 
be saved as a comma-separated-variable file using the export button. 
 
View→ Properties:  Used to open and close the Element Properties window 
View→ History:  Used to open and close the Simulation History window 
 
Closing the Simulation and/or Element Properties window frees up more of the SRB window 
space for the Schematic and Graphing windows.  The relative size of the various windows can by 
changed by selecting and dragging the border regions of the windows. 
 
Graph → Copy to Clipboard: Used to copy a bitmap image of the currently displayed graph to 
the clipboard.  The image can then be pasted in other documents (MS Word™, MS Powerpoint™, 
etc.). 

 
Figure 8.2.  The Summary Table, which can be used to save a summary of the results for a 
simulation, or copy the results into a spreadsheet. 
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9. Example MINUHET schematic construction for a 
residential watershed 
 
The following section describes an example of the application of MINUHET to a 12.5 acre land 
parcel with residential development.  The study site is located in a residential area of Plymouth, 
MN, a city in the Minneapolis/St. Paul metropolitan area. The development consists of 39 houses 
on roughly 12.5 acres of land, 24% of which is connected impervious area (Table 9.1). 
Construction began on the development more than 20 years ago; the area has more mature trees 
and vegetation than would be typically found in a new development. 
 
Although there is not a direct interface between MINUHET and GIS packages, GIS is a useful 
tool for characterizing a land parcel to determine the required input data for MINUHET. In the 
case of the Plymouth watershed, a delineation of the drainage area and highly detailed land use 
data was provided by the Three Rivers Park District. Storm sewer plans as well as elevation 
contour maps for both pre-development and post-development conditions.  A GIS map of the 
study site is given in Figure 9.1, showing the houses, streets, driveways, and pervious areas.  
Based on this information, the sub-watershed input data for MINUHET was assembled, as given 
in Table 9.2.  The storm sewer map was used to create Table 9.3, which summarizes the four 
sewer pipe sections, as illustrated in Figure 9.1.  Further details on the application of MINUHET 
to this watershed are given in SAFL Project Report #497 (Janke et al. 2007). 
 
The flow routing schematic for this watershed is shown in Figure 9.3. In this case, the two pairs 
of catch-basins located across the street from each other were combined, resulting in two catch 
basins (CB) and 1 junction for the model.  Figure 9.4 gives the implementation of the flow 
routing schematic into MINUHET, where the elements have been arranged so that the flow goes 
from top to bottom.  The MINUHET schematic could also be arranged as in Figure 9.2, since the 
flow direction is not dependent on the spatial position of the elements in the schematic. 
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Figure 9.1.  Schematic of study site, residential 
development in Plymouth, MN. 
 
 
Table 9.1.  Characterization of impervious areas within the Plymouth watershed 

Total Area Street Roofs Connected Roof Driveways Sidewalk Connected % of 

(m²) (m²) (m²) (m²) (m²) (m²) Impervious (m²) Watershed

50390 6536 8078 940 4089 456 12021 23.9%
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Figure 9.2. Division of study site into sub-watersheds 
SW1-SW5. Direction of overland runoff is also shown.  
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Figure 9.3.  Flow routing schematic for the 
Plymouth watershed. 

Figure 9.4.  Flow routing schematic 
implemented in MINUHET 
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Table 9.2. Sub-watershed parameters for the example Plymouth watershed 
Sub-watershed  SWS01 SWS02 SWS03 SWS04 SWS05 

Description 
SW 
Corner 

SE 
Corner Greenspace

NE 
Corner 

NW 
Corner 

Connected Impervious 

Length (m) 63.3 43.5   26 62.6 

Paved Area (m2) 2155 1889   1677 5323 

Conn. Roof (m2) 197 226   155 318 
Shading (%) 10 0   0 10 

Wind Sheltering (%) 0 0   0 0 
Slope 0.0162 0.0128   0.026 0.026 
Pervious (Grass, Trees) + Disconnected Impervious 

Length (m) 36.2 27.9 23.2 23.2 42.2 

Pervious Area (m2) 5899 5881 5007 5537 8533 

Disconn. Roof (m2) 1445 1654 858 1135 2336 
Shading (%) 20 50 80 20 50 

Wind Sheltering (%) 0 ? 0 0 0 
Slope 0.0256 0.0167 0.064 0.04 0.0441 

Soil Type B B B B B 

Veg. Type 
Short 
Grass 

Short 
Grass Short Grass 

Short 
Grass 

Short 
Grass 

Veg. Density 0.9 0.9 0.9 0.9 0.9 
 
Table 9.3. Storm sewer parameters for example Plymouth watershed 

Pipe  P1 P2 P3 P4 

Length (m) 51.7 24.2 52.3 64.6

Diameter (m) 0.305 0.305 0.457 0.381

Roughness 0.012 0.012 0.012 0.012
Slope (m/m) 0.048 0.0045 0.0092 0.075

Depth (m) 2.5 2.5 2.5 2.5
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10. Error messages and troubleshooting 
 
The MINUHET tool is designed to give reliable simulation results for reasonable watershed 
specifications.  MINUHET has error checking and reporting on several levels.  The graphical 
user interface (GUI) does some simple checks and reports warnings and errors with a pop-up 
window. 
 

 During the schematic building process, MINUHET will not allow “illegal” connections,  
e.g. connecting two sub-watersheds together without a junction element, or connecting a 
sub-watershed or a junction directly to a pond inflow. 

 If a schematic contains multiple, disconnected drainage networks, MINUHET gives a 
warning as a simulation is attempted.  The simulation may proceed if desired, giving a 
separate multiple flow/temperature solution for each system. 

 
 
The FORTRAN executables report problems on reading input files, bad sub-watershed 
parameters (e.g. Area=0), and solution convergence problems to a test file (error.txt), which is 
then automatically displayed by the GUI in a pop-up window. 
 
All sub-watershed elements must have at least one positive area (Impervious or Pervious) with 
positive, length, and slope.  Attempting to run a simulation with ill-specified subwatershed 
elements will result in an error message. 
 
All routing elements (pipes and open-channels) must have positive length, diameter or width, 
slope, and roughness specified.  If the calculated inflow rates from the sub-watersheds exceed the 
capacity of the storm sewer system (pipe elements), a flow solution convergence error may result 
and the simulation is stopped.  The user can then modify the sewer system, e.g. increase the pipe 
diameters, or run a lower intensity storm event. 
 
Generally, MINUHET should not report file reading problems, since all input files are either 
permanently stored or created in the correct format by the GUI.  File read errors are then likely to 
be the result of accidentally deleting, moving, or modifying the permanent data files (global.dat, 
storm data files) in the MINUHET/Toolspace directory. 
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Appendix 1:  Files formats used by MINUHET 
 
Storm file format 
 
The following page gives a sample storm file used by MINUHET.  The example file is much 
shorter than the typical 2 week duration, to better illustrate the file structure. 
 
The first seven lines are comment lines that are not used by MINUHET. 
 
The WRUN parameter set (FORTRAN namelist) contains three parameters:  WSTART and 
WSTOP are the start and stop times, in days, for the given climate data. ASTART is the runoff 
analysis start time, usually just prior the storm event of interest.  Both WSTART and WSTOP 
are in days, referenced to January 1, 1900 (Excel time format).  TSTEP is the time step, in 
minutes, of the climate data. 
 
WDATA is parameter set (namelist), containing WDAT, the (NWD x 6) array containing the 
climate data, with comma separation.  Column 1 is Air Temperature (°C), column 2 is Relative 
Humidity (%), column 3 is Solar Radiation (W/m2), column 4 is Wind Speed (m/s), column 5 is 
Precipitation Depth (cm), and column 6 is Cloud Cover fraction (0=clear, 1= full cloud cover).  
The climate data array may optionally end with a “/” delimiter, as shown. 
 
The example file format given below is truncated to fit it on 1 page. The example uses comma 
delimited format; tab delimited file formats are also acceptable. 
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! MINUHET synthetic design storm file 
! Contains site run time parameters and weather data 
! WSTART=start date/time for weather data in Excel format 
! ASTART=start date/time for runoff analysis in Excel format 
! TSTEP = weather time step (minutes), NWD = number of weather time steps, 
! WDAT=weather data (air temp (C), RH (%), Solar (W/m^2, Wind (m/s),  
! Precipitation (cm), Cloud Cover Fraction (0=clear, 1= full cloud cover) 
   
&WRUN 
WSTART=36365.00000    
WSTOP=36373.00000    
TSTEP=15.0/ 
   
&WDATA 
WDAT =  
18.9, 85.4, 0.0, 0.32, 0.00, 0.2 
18.8, 85.5, 0.0, 0.37, 0.00, 0.2 
18.9, 86.2, 0.0, 0.34, 0.00, 0.2 
18.8, 87.3, 0.1, 0.54, 0.00, 0.2 
18.6, 87.7, 0.2, 0.70, 0.00, 0.2 
19.1, 86.5, 0.1, 1.21, 0.00, 0.2 
19.1, 86.8, 0.1, 0.93, 0.00, 0.2 
18.9, 88.8, 0.1, 1.31, 0.00, 0.2 
18.9, 88.6, 0.1, 1.17, 0.00, 0.2 
18.5, 90.9, 0.1, 1.01, 0.00, 0.2 
18.1, 92.6, 0.0, 0.71, 0.00, 0.2 
17.7, 94.0, 0.0, 0.60, 0.00, 0.2 
17.8, 94.8, 0.0, 0.38, 0.00, 0.2 
17.7, 95.3, 0.0, 0.29, 0.00, 0.2 
17.4, 96.1, 0.0, 0.58, 0.00, 0.2 
17.7, 96.2, 0.0, 0.70, 0.00, 0.2 
17.9, 95.7, 0.3, 0.76, 0.00, 0.2 
18.2, 95.3, 0.4, 0.69, 0.00, 0.2 
18.4, 94.8, 0.4, 0.62, 0.00, 0.2 
18.6, 94.4, 0.5, 0.55, 0.00, 0.2 
18.6, 94.2, 0.6, 0.20, 0.00, 0.2 
18.5, 95.3, 1.0, 0.48, 0.00, 0.2 
18.7, 95.3, 0.5, 0.28, 0.00, 1.0 
19.4, 95.4, 1.4, 3.81, 0.03, 1.0 
19.1, 97.4, 2.8, 2.18, 0.03, 1.0 
18.5, 98.6, 3.0, 0.97, 0.00, 1.0/ 
 


